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ServiceCenter 6 Release Notes
Welcome to Peregrine Systems, Inc.’s ServiceCenter 6. The purpose of this 
document is to provide an overview of new features, describe known issues 
with this release, and provide instructions for you to access information from 
other sources, such as documents on the Peregrine Customer Support web 
site.

Ensure that you have a valid Customer Support login ID and password before 
you begin. You can access the Customer Support Web site at:

http://support.peregrine.com

The packing list included with your shipment identifies the media shipped to 
your site.

Getting started

To understand ServiceCenter 6, review the following information:

Read Comparing clients on page 6.

Read New features on page 8.

Follow instructions to review the Compatibility matrix on page 13.

Follow instructions to review Software Change Requests (SCRs) on 
page 13.

Read the Known issues, starting on page 14.

Follow instructions to review other Documentation on page 34.
ServiceCenter 6 Release Notes  5
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Comparing clients

The following table compares the ServiceCenter client features in 
ServiceCenter 6 with those offered in previous versions.

 
 
 
Feature

 
Version 6 
Windows 
client

 
 
Version 6 
Web client

Version 6 
Web client 
(accessible 
mode)

 
Version 5.1.x 
Windows 
client

 
 
Version 5.1.x 
Java client

Automatic client 
updates

Yes N/A N/A No Yes

Binary load and 
unload

Yes Server-side 
only

No Yes Yes

Charts and 
Dashboards

Yes Yes Yes. Available 
but not 
accessible.

No No

Client repackaging Yes N/A N/A No No

Client connection 
manager

Yes No No No No

DDE Integration, 
including Excel 
export

Yes No No Yes Yes

Direct URL access No Yes No No No

Drag-and-drop Yes Yes1 No No No

Elastic form 
properties2

Yes No5 Yes Yes Yes

Favorites Yes Yes No No No3

Forms Designer Yes No No Yes Yes

Graphical Workflow Yes Yes No No No

Magnify glass for 
input fields

Yes No No Yes Yes

Maximize List and 
Detail panes

Yes No No No6 No6
6  ServiceCenter 6 Release Notes 
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Multiple marquees 
per format

Yes No. All 
Marquees are 
combined into 
a single 
Marquee per 
format.

No. All 
Marquees are 
static text 
fields.

Yes Yes

New GUI format 
print

Yes Yes Yes No No

QBE List DVD colors Yes No No Yes Yes

RAD Debugger Yes No No Yes Yes

Spell checker Yes No Yes Yes Yes

SSL encryption Yes Yes No No No

System Navigator Yes Yes No No No4

TAPI integration No No No Yes Yes

Text and CSV export Yes No No Yes Yes

Unicode (UTF-8) 
data

Yes Yes Yes Single code 
page only

Single code 
page only

1 Only supported with Microsoft Internet Explorer (IE).
2 Known Issues 
3 Java Explorer favorites available 
4 Java Explorer available 
5 For font resizing, only partial elastic support is enabled
6 Ability to enable or disable record list.

 
 
 
Feature

 
Version 6 
Windows 
client

 
 
Version 6 
Web client

Version 6 
Web client 
(accessible 
mode)

 
Version 5.1.x 
Windows 
client

 
 
Version 5.1.x 
Java client
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ServiceCenter
New features

ServiceCenter 6 includes an updated version of the ServiceCenter server and 
two new clients. ServiceCenter 6 also takes advantage of new techniques in 
system management, enterprise integration, and user interfaces and uses the 
latest Web-based technologies, such as SOAP, DHTML, HTTP, HTTPs, and 
XML to provide an open, yet secure platform that can share data with other 
enterprise systems. Enhancements in ServiceCenter 6 benefit application 
developers, administrators, and end users.

One of the goals of this release is to lower administrative requirements with 
the introduction of the Web client, a platform-independent, browser-based 
client with a zero footprint. In addition, users experience an increase in user 
productivity through improved access to information. To meet your 
business needs, ServiceCenter 6 introduces an extensible SOAP API that 
enables developers to integrate ServiceCenter with other enterprise 
applications.

This release incorporates the following technologies:

Extensible Markup Language (XML)

Server-side JavaScript support

Simple Object Access Protocol (SOAP)

Unicode Transformation Format (UTF-8) support

In addition, this release offers customizable accessibility features that enable 
all users to work efficiently with ServiceCenter.

The following sections highlight new features offered with ServiceCenter 6. 
For additional details about the features in the sections below, you can install 
the Windows client or a Help server to review the What’s new in ServiceCenter 
section of the online help.

See Accessing online help from a Windows client on page 34 for instructions to 
access the online help from a Windows client or use the instructions 
provided in the ServiceCenter Installation Guide to install the Help server.
8  ServiceCenter 6 Release Notes 
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What’s new for application developers?
The following table highlights some of the new features available for 
application developers.

Feature Application developer usage

Differential Upgrade 
utility

The Differential Upgrade utility ports changes from 
one system to another. For example, you can use this 
utility to move changes from development to test and 
then on to production systems.

Form layout and design You can now use drag-and-drop capability and added 
controls to design forms.

JavaScript support Server-side JavaScript support, in addition to the 
continued support of Rapid Application Development 
(RAD) statements, allows you to tailor your 
application using JavaScript.

ServiceCenter debuggers ServiceCenter debuggers allow you to use RAD or the 
Advanced Debugger to debug RAD and JavaScript 
statements.

SOAP API1 ServiceCenter 6 can now expose its applications and 
data as Web Services by dynamically generating Web 
Service Description Language (WSDL) upon request. 
The SOAP API allows you to access ServiceCenter 
applications and data using any compliant third-party 
SOAP tool kit, such as Apache Web Services Project 
(Axis), the Microsoft(R) .NET Framework Software 
Development Kit (SDK), or Sun’s Java Web Services 
Developer Pack.

SSL Encryption You can now encrypt and decrypt data between your 
client and server using Secure Sockets Layer (SSL) 
Encryption.

1Access to ServiceCenter 6 application features using SOAP clients provided by 
customers or partners require that you license both the SOAP API and the module 
whose functionality is being accessed using SOAP.
New features  9
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What’s new for administrators?
Administrators benefit from simplified data and system management. They 
now have access to the tools they need from a Windows navigator with links 
to related tasks and information. The addition of drag-and-drop 
functionality simplifies many administrative tasks.

The following table highlights some of the new features available for 
administrators.

Feature Administrator usage

Client Packaging Utility The Client Packaging Utility allows the deployment of 
a rebranded Windows client, a single configuration for 
all users, or multiple client configurations for various 
groups.

Connections dialog The Connections dialog allows administrators to 
configure and deploy default server connections for all 
users in conjunction with the Client Packaging Utility. 
In addition, users are allowed to maintain multiple 
ServiceCenter server connections within a single client.

Customizable online help 
system

Administrators can now edit HTML and XML online 
help files.

Entity Relationship 
Diagram Creation utility

The Entity Relationship Diagram Creation utility 
allows administrators to generate Database Definition 
Language (DDL) statements that can be imported into 

many data modeling tools, including the AllFusionTM 
ERwin Data Modeler by Computer Associates (CA).

Preferences Preferences options assist administrators in setting up 
and deploying preferences for charts, clients, online 
help, the Help server, and logs preferences.

Scheduled Maintenance 
exception models

Scheduled Maintenance exception models allow 
administrators to take advantage of new techniques to 
execute maintenance tasks.

ServiceCenter Help server The ServiceCenter Help server provides an option to 
centralize the location of online help.

System Navigator System 
Definition

The System Navigator System Definition allows quick 
access to information about ServiceCenter files, 
records, forms, and many tailoring tasks.
10  ServiceCenter 6 Release Notes 
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Update Site Utility The Update Site Utility centralizes file locations to 
enable you to download updates for Windows clients 
using files provided by Peregrine without reinstalling 
clients.

User license tracking User license tracking allows administrators to track 
Floating and Named licenses at the application level.

UTF-8 (Unicode) 

support1
UTF-8 support allows a single server to store and 
display data in any number of character sets.

Web tier The Web tier supports a platform-independent, 
browser-based client with a zero footprint. For 
additional information about supported platforms, 
follow the instructions in the section titled, 
Compatibility matrix on page 13.

 
1 Use of earlier versions of the clients is not recommended when using mixed 
languages on the same server. Earlier versions of the clients are limited to data entry 
and display of characters from a single code page.

Feature Administrator usage
New features  11
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What’s new for end users?
ServiceCenter 6 introduces new Windows and Web clients. These clients 
provide an environment that is easy for all end users to access the 
information and tools they need to do their jobs.

The Web client is scalable, with the ability to support global users securely. 
The Web tier is platform-independent, browser-based, and the only system 
resource required is a compatible browser. The Web client provides the same 
tools and access to information as the Windows client. The Web client is 
server based, therefore users always access the latest updates when they log in.

The Windows client has the ability to access client updates from a centralized 
location at login time without redeployment of the client. 

Both clients offer access to necessary information through tree navigation, 
personal and public folders with favorites, charts, and dashboards.

Feature End user usage

Charts and dashboards Users can view chart and bar graphs that display 
relationships among categories of data.

Connections dialog The Connections dialog defines multiple client to 
server connections.

Favorites Favorites allow users to bookmark frequently visited 
forms, queries, and applications.

Graphical Workflow Graphical workflow displays a visual representation of 
phases and approval cycles in Change Management 
and Request Management.

Preferences The Preferences dialog allows users to quickly set and 
change client preferences.
12  ServiceCenter 6 Release Notes 
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Compatibility matrix

The compatibility matrix, including versions of operating systems, servers, 
web servers, Web application servers, clients, Relational Database 
Management System (RDBMS) systems, and compatibility with other 
Peregrine products is available on the Customer Support Web site.

Accessing the compatibility matrix for ServiceCenter

1 Open a browser and navigate to the Peregrine Customer Support Web site at:

http://support.peregrine.com

2 Log in with your Customer login ID and password.

3 Expand the product information topic in the left frame by clicking Product 
Information > Service Management > ServiceCenter > Compatibility 
Matrices.

4 Click ServiceCenter in the right frame to display a list of ServiceCenter 
versions.

5 Click ServiceCenter 6 to display the Compatibility Matrix for this release.

Software Change Requests (SCRs)

ServiceCenter 6 includes fixes for many Software Change Requests (SCRs). 
You can view these the SCRs fixed for this release, as well as details for other 
corrections and enhancements in ServiceCenter releases 4.0 and above, on 
the Customer Support Web site.

Searching for SCRs from the Customer Support Web site

1 Open a browser and navigate to the Peregrine Customer Support Web site at:

http://support.peregrine.com

2 Log in with your Customer login ID and password.

3 Expand the product information topic in the left frame by clicking Product 
Information > Service Management > ServiceCenter > View SCRs.

4 You can filter the criteria by selecting the version, category, or subcategory 
for SCRs to search

5 A report matching your criteria is then displayed. You may view the report 
or, optionally, click Create Excel Report to download a spreadsheet with the 
contents matching your search criteria.
Compatibility matrix  13
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Known issues

You can view a complete list of known issues for this and previous releases by 
searching the Knowledgebase located on the Customer Support Web site.

Searching for known issues in the Knowledgebase

1 Open a browser and navigate to the Peregrine Customer Support Web site at:

http://support.peregrine.com

2 Log in with your Customer login ID and password.

3 In Step 1, Search Knowledgebase, select ServiceCenter (K&B 
Documentation) from the pull-down menu.

4 In Step 1, click Advanced Search.

5 From the Advanced Knowledgebase Search dialog, type Known Issue in the 
Search Criteria text box.

6 Select ServiceCenter (KB & Documentation) from the pull-down menu in 
Step 1.

7 Select Both the KB and the Documentation from the pull-down menu in 
Step 2.

8 Select ServiceCenter 6 from the pull-down menu in Step 3.

9 Click Search.

10 Click on a document to open it.
14  ServiceCenter 6 Release Notes 
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The following table contains a summary of selected known issues for 
ServiceCenter 6. 

Knowledge Articles for ServiceCenter 6

Document ID Known issue Workaround

DSC-6000-31736 Telephony Applications Programming 
Interface (TAPI) is not supported with the 
version 6 Windows client.

None.

DSC-6000-31757 Screen readers are inconsistent when 
reading field descriptions on the Web 
client while logged in as an administrative 
user and using the TAB key to tab between 
field descriptions.

When you log in as an end user, such as 
BOB.HELPDESK, titles and field 
descriptions are read when the screen is 
automatically read by the screen reader. If 
you manually tab through the fields, the 
titles and field descriptions are not read by 
the screen reader.

These titles and field descriptions are 
most often those that do not contain an 
input text field or link associated with 
them. For example, if you log in as 
BOB.HELPDESK and then click 
Maintenance > Contacts, the Form 
Options description and the Corp 
Struct/Div title are not read when tabbing 
through the screen. The Corp Struct/Div 
title has a text field and Fill form 
associated with it.

When logged in as an administrative user 
on the Web client, do not use the TAB key 
to move between field descriptions.

DSC-6000-31772 The Web client is difficult to use in 
Japanese. This problem occurs because, to 
use the Japanese Input Method Editor 
(IME), you must type the phonetics of the 
words you want, space one or more times 
to get the ‘kanji’, and then click Enter to 
select the kanji. Clicking Enter to select 
the kanji triggers the browser to submit 
the form prematurely.

You can enable the autosubmit parameter 
in the web.xml file for the entire web 
server, or enable it for a specific URL for 
an individual user.

For more details about the autosubmit 
parameter, see the ServiceCenter 6 online 
help.
Known issues  15
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DSC-6000-31789 The ServiceCenter Web client uses 
version 2.3 of the servlet specification and 
the WebSphere Application Server 
version 4 uses an earlier version. Errors 
can occur when running the 
ServiceCenter 6 Web client with a 
WebSphere 4 application server. These 
errors are written to the standard-out log 
file for the server, stdout.txt, or 
standard-error log file, stderr.txt, and are 
similar to the following example: 
:java.lang.reflect.InvocationTargetExceptio
n: java.lang.IllegalAccessError: cannot 
access superclass 
org/apache/xml/dtm/ref/DTMDefaultBase
Iterators$InternalAxisIteratorBase  from 
class 
org/apache/xml/dtm/ref/sax2dtm/SAX2
DTM2$AncestorIterator at 
org.apache.xalan.xsltc.dom.XSLTCDTMMa
nager.getDTM(XSLTCDTMManager.java:36
7) at 
org.apache.xalan.xsltc.dom.XSLTCDTMMa
nager.getDTM(XSLTCDTMManager.java:17
5) at 
org.apache.xalan.xsltc.trax.TransformerIm
pl.getDOM(TransformerImpl.java:531)

Perform the following steps to install the 
JAR files needed to correctly run the 
ServiceCenter 6 Web client with a 
WebSphere 4 application server:

1 Navigate to the section in the 
Installation Guide, titled "Installing 
additional JAR files for your Web 
application server" and use the steps in 
that procedure to correctly copy the 
needed JAR files for your WebSphere 
Application Server.

2 Add the jaas.jar JAR file to the 
.../$WAS_HOME/java/jre/lib/ext 
directory. 
You can download this file from Sun at: 
http://java.sun.com/products/jaas/

3 In the .../$WAS_HOME/lib/app 
directory, add the xalan.jar file, the 
xercesImpl.jar file, and the xml-apis.jar 
file. 
These three JAR files are included in the 
xalan-j_2_5_1.zip file. You can 
download this zip file from     
http://xml.apache.org/.

DSC-6000-31796 Client features in ServiceCenter 6 differ 
with those offered in previous versions. 
ServiceCenter 6 supports the following 
client types:

Windows client
Web client
Web client (accessible mode)
5.1.x Windows client
5.1.x Java client

For a list of features offered with each 
client type, see the comparison table 
Comparing clients on page 6.

Knowledge Articles for ServiceCenter 6

Document ID Known issue Workaround
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DSC-6000-31132 The ServiceCenter client is required to be 
installed by an Administrator or Local 
Administrator on a Windows operating 
system. This requirement causes the Start 
menu link to only appear for the user that 
installed the software.

To ensure users can have their own 
‘Workspace’ folder, use one of the 
following two methods that enable users 
(other than Administrators or Local 
Administrators) to share access to the 
ServiceCenter client.

1 Manually create the Start menu 
shortcut on one machine and specify 
that the Start in directory is a directory 
that is unique or local to the user. For 
example, you can use the 
%USERPROFILE% environment variable 
as the value for the Start in field in the 
shortcut to create a shortcut for all 
users. 
– OR –

2 Create shortcut files that contain a 
unique Start in value, such as using the 
%USERPROFILE% environment variable 
and then sharing that file on the 
desktop. 

DSC-6000-31148 Adding a new field to a dbdict record for a 
SQL-converted file will not save the 
generated mapping in the dbdict record. 
An error message is not generated and the 
system appears normal until you attempt 
to use the new field and cannot. When 
you attempt to add another field to the 
same dbdict, the System Navigator 
generates an ALTER TABLE statement for 
both fields since the first one is not yet 
mapped. The ALTER TABLE command 
statement generated fails due to a 
duplicate column name.

Adding a new field to a dbdict record for a 
SQL-converted file will do the following:

Add the field to the dbdict and save it.
Map the dbdict.
Based on the mapping generated, it will 
execute an ALTER TABLE statement 
for the table to add the new column.

Use the dbdict utility to add new fields if 
the dbdict you intend to modify is 
converted to SQL.

Knowledge Articles for ServiceCenter 6

Document ID Known issue Workaround
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DSC-6000-31163 On a Windows client, you cannot use the 
CTRL+C or CTRL+V keystroke 
combination to copy or paste if the Show 
XML forms preference option is checked. 

You can copy and paste using CTRL+C 
and CTRL+V if you deselect the option to 
display XML forms and data.

Use the following steps to deselect this 
option:

1 Click Window > Preferences.
2 Uncheck the Show XML Forms check 

box.
3 Click Apply.
4 Click OK.
You can optionally use the mouse to 
right-click the selection and then use 
Copy or Paste from the right-click menu.

DSC-6000-31165 On ServiceCenter 6, the Open Database 
Connectivity (ODBC) driver is not 
backwards compatible with previous 
server versions due to changes in Unicode 
(UTF-8) support.

Ensure that your ODBC driver uses a 
supported UTF-8 language and that it is 
compatible with UTF-8 conversion 
procedures.

DSC-6000-31194 You cannot use the Export to Text File 
option on the Web client when typing in 
the fully-qualified path and file name.

When using the Export to Text feature on 
the Web client, do not include a drive 
location and path name in the name you 
select for your exported file. For example, 
use exported_text.txt instead of 
C:\exported_text.txt.
The file is exported to the hard drive on 
the ServiceCenter server. If you do not 
specify a path, the file is saved to the 
.../ServiceCenter/RUN directory.

DSC-6000-31264 When running a ServiceCenter version 6 
server and saving records to an external 
unload file, you can only read the unload 
files on systems that are also running a 
version 6 or greater server. Unload files 
created from systems running on version 
5.1.x or earlier can be loaded into 
ServiceCenter 6. 

None. To read unload files created on 
systems running a version 6 server, you 
must read the files on a supported system 
that is running a ServiceCenter server at 
version 6 or greater.

Knowledge Articles for ServiceCenter 6

Document ID Known issue Workaround
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DSC-6000-31282 The ServiceCenter 6.0 client does not use 
the sc3user.ini file to contain 
configuration settings and user 
preferences. The ServiceCenter 6.0 
Preferences and the Connections dialogs 
contain all user-specified preferences and 
store them locally in the client workspace 
folder.

The sc3user.ini file and its associated 
parameters are now obsolete. You can set 
Preferences in a client and then repackage 
it or you can instruct users to individually 
set their Preferences.

DSC-6000-31349 The Windows client supports dynamic 
layout, including text wrapping and 
automatic resizing, allowing fields to 
expand or contract as the form size 
changes. Forms created using the GUI 
client on versions prior to 6.0 may display 
differently on the Windows 6.0 client. For 
non-Windows clients, the forms are 
rendered based on a strict grid layout.

None. You can use the Windows 6.0 client 
to modify forms created in previous 
versions to display correctly using the 
Windows 6.0 client.

DSC-6000-31437 The validate format option that was used 
in previous versions of ServiceCenter to 
determine parameter name uses when 
calling a Rapid Application Development 
(RAD) function, does not function in 
ServiceCenter 6.

You can only use the validate format 
option with a version 5.1.x client. You can 
optionally use the Show XML form 
option and view the XML to determine 
the parameter name used. The values that 
previously displayed when using the 
validate format option are shown in the 
XML tags.

DSC-6000-31464 The print icon and printing using File > 
Print List prints only the records that are 
currently displayed in list.

To print the entire list of records using the 
Print icon or the File > Print List option, 
use the CTRL+SHIFT+END keystroke 
combination to load the entire list and 
then select Print. Selecting the entire list 
also gives you the ability to cancel out of a 
print operation if the list returned is larger 
than you expected and you choose to 
abandon the print request.

Note:  Consider that large record lists 
take longer to load.

DSC-6000-31480 When you are in a menu using the Web 
client, neither the Escape (ESC) key or 
function keys, such as F3, are recognized.

When you are in menus using the Web 
tier client, use the cursor and mouse to 
navigate. Do not use the ESC key or 
function keys.
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DSC-6000-31506 If the viewing area for the editor is not 
large enough to show an entire form, the 
client automatically scrolls the form to 
ensure that the currently focused control 
is visible. For example, when you have the 
Navigator visible on the left of the screen 
and a Dashboard open on the right, the 
form may scroll left and right as focus 
moves from one control to another.

This scrolling effect can be reduced or 
eliminated by repositioning or resizing 
your views. You can quickly maximize the 
format by double-clicking on the tab for 
that item or you can drag-and-drop items 
from your work area to another area of 
the screen.

DSC-6000-31540 When you create a Favorite of a menu by 
dragging the Navigator icon for the menu 
item to the tree view, a link is created to 
that record. When later selecting the link, 
the record displays in the default form.

You can correctly create a Favorite for a 
menu by dragging and dropping the link 
from the Menu Navigation tree node 
directly to a Favorite folder.

DSC-6000-31576 When the Show Detail pane with the 
Record List preference in Forms Designer 
is not selected, you cannot set focus and 
edit the objects using Forms Designer.

Use the following steps to set focus and 
edit objects using Forms Designer with 
the Show Detail pane in the Record list 
preference:

1 From the ServiceCenter pull-down 
menu, select Windows > Preferences > 
ServiceCenter.

2 Select the Show Detail Pane with 
Record List preference.

3 Click Apply.
4 Click Cancel two times to exit the 

Design mode and return to the Forms 
Designer search dialog.

5 Enter contacts.g as the form name.

6 Click Search.
7 Click the Design button to set the focus 

on an object on the form.

DSC-6000-31626 On a Windows client, automatic scrolling 
can hide the error message display area. 
When you scroll downward, the messages 
displayed are not visible. If you perform 
an action that causes a message to appear, 
the message is out of display range and 
you will not be aware that it has occurred.

Use the following steps to ensure that 
messages display correctly on the 
Windows client:

1 For a Windows client, select Windows 
> Preferences > ServiceCenter.

2 Select the Active Notes check box.
3 Click OK.
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DSC-6000-31657 Each server process makes an attempt to 
send a shutdown message to the 
associated client when it receives a signal 
to terminate. Although this attempt is 
normally successful, a connection failure 
that causes the error is sometimes 
reported. This behavior is dependent on 
timing and typically performs as expected 
because it relies on the client retrieving 
the shutdown notification message using 
the heartbeat mechanism.

None. Use the broadcast message feature 
to notify users of pending shutdown 
events.

DSC-6000-31679 When a session is lost due to inactivity, 
empty charts display when you reconnect.

After losing a connection due to 
inactivity, you must close the Dashboard 
and then reopen it to properly display 
chart data.

DSC-6000-31697 When using the drill-down method on a 
chart when the chart data is not a text 
string, such as numeric, you may receive 
inaccurate results. Dashboards and charts 
in ServiceCenter 6 assume that the 
breakdown data is a text string and 
therefore assumes that same criteria when 
performing the drill-down query on a 
chart.

None.

DSC-6000-31719 When launching an external application 
with a version 6 Windows client, the 
application may launch two sessions.

Close the second session or use a version 
5.1.x client to launch external 
applications.
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DSC-6000-31723 Due to the new architecture of IR expert, 
insert operations on files with IR key 
perform slower. This is because the IR 
expert indices are stored in a file called 
scirexpert, which can be converted to a 
Relational Database Management System 
(RDBMS). File loads, particularly with 
IR-indexed files, may be significantly 
slower. 

To increase performance for insert 
operations, ensure that you assign enough 
shared memory to cache the IR indices. 
You can either increase the overall shared 
memory size, or use the ir_max_shared 
parameter to assign a larger segment of 
your shared memory to IR expert.

For additional performance, you can do 
one or both of the following to decrease 
the size of the IR index and reduce 
resources used to maintain that index.

Leave the scirexpert file on P4.
Use the stop words file to limit the 
number of updates.
Modify your IR keys to include fewer 
fields.
Archive and purge records from your 
IR-indexed file.

DSC-6000-31724 If a SQL-converted dbdict is deleted using 
the dbdict utility and then restored 
immediately from an unload file, the 
dbdict is created in P4, but the data from 
the unload file is added to the Relational 
Database Management System (RDBMS) 
tables. This occurs because the RDBMS 
tables were not deleted by the dbdict 
utility.

This only occurs if you have a P4 file 
system. The dbdict definition is not 
correctly flushed after deletion of the 
dbdict and the RTE therefore assumes 
that the file still exists in the RDBMS.

After deleting the dbdict using the dbdict 
utility, log out and then log back in before 
loading the unload file.

DSC-6000-31725 Constant disconnecting and connecting 
to the Sybase database causes internal 
pointers to SQL buffers to be become 
invalid and then causes an abend.

Do not use sqldisconnect:1 when running 
Sybase.
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DSC-6000-31729 When viewing the System Status using the 
Web Client, the vertical and horizontal 
scroll bars do not display in order to view 
the full screen and all system processes.

This occurs due to a known documented 
issue with Microsoft Internet Explorer 
(IE) caused by Cascading Style Sheets 
(CSS) using framesets. The use of 
absolutely positioned and sized DIVs 
causes there to be no scroll bars or 
inadequate scrolling of a page.

For more information about the 
Microsoft issue, see the article titled, “CSS 
Enhancements in Internet Explorer 6” at: 
http://msdn.microsoft.com/library/default.
asp?url=/library/en-us/dnie60/html/cssen
hancements.asp

None.

DSC-6000-31734 When using relative dates in a Favorites 
query, such as ‘Tickets opened today’, you 
must manually override the stored query. 
This occurs when you save a date-related 
query result as a Favorite and the date 
arguments are resolved to use the absolute 
date. For example, in the saved query 
open.time>date(tod()), the Favorite 
displays open.time>'1/1/04 00:00:00' after 
it is saved. This also occurs when charts 
are saved as Favorites.

Use the following steps to enable the 
relative date function tod() in Favorites:

1 Right-click on the Favorite and click 
Edit.

2 Modify the query expression to include 
the appropriate query logic.

DSC-6000-31735 When the Windows client performs a 
routine check for software updates at 
startup, the password-required dialog 
does not display in front of other 
windows. This only occurs when the 
update site is password protected and also 
applies to subsequent dialogs, such as the 
Progress Information and New Updates 
dialog.

This problem most often occurs when a 
user switches applications while waiting 
for the Windows client to load.

Use the ALT+TAB keystroke 
combination to navigate to the required 
dialog.

DSC-6000-31739 Due to problems with the Netscape 
browser, the functionality for printing 
from Netscape is disabled.

None. Use Microsoft Internet Explorer 
(IE) to print from a browser.
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DSC-6000-31740 During the server installation, the name of 
the folder that displays for ServiceCenter 
in the Start > Programs folder is set and 
cannot be modified. The name in 
Add/Remove Programs > Currently 
Installed Programs is also set and cannot 
be modified. The installation is set to be 
user-specific, which prevents conflicts if 
you need to install multiple server 
instances on the same Windows machine.

None recommended. A workaround 
would require moving of files that could 
compromise future ServiceCenter 
upgrades and is therefore not supported. 
The current design adheres to industry 
standards for software installation.

For more information about installing 
multiple servers on one Windows 
machine, see the Installation Guide.

DSC-6000-31743 When using the screen reader on a Web 
Client in accessible mode, the IBM 
Homepage reader interprets or reads a 
single checkbox as though it is two 
checkboxes. This is an apparent anomaly 
in the JavaScript function that controls 
this element.

None. You can adjust the settings for the 
screen reader to achieve improved results. 
See the accessible version of the IBM 
screen reader documentation to 
customize settings.

DSC-6000-31746 When using the Web client in accessible 
mode, the code for a page determines the 
capability of the reader to interpret record 
lists with a header and then interpret the 
data for each entry. Depending on the 
configuration of your screen reader, some 
record lists may not be accurately 
interpreted by the screen reader.

None. See the accessible version of the 
IBM screen reader documentation to 
customize settings.

DSC-6000-31750 On the Windows client, using the 
CTRL+END keystroke combination 
advances you to the end of the currently 
retrieved records instead of the end of all 
records.

This is normal behavior for the Windows 
client, which is built on an Eclipse 
platform. You can use the 
CTRL+SHIFT+END keystroke 
combination to advance to the end of all 
records.

DSC-6000-31751 Controls with the property Case 
Conversion set to Upper or Lower always 
displays the data as case-converted, 
regardless of how the data is stored in the 
database.

None. When designing forms, ensure that 
the display options are consistent with 
data properties. This behavior is 
as-designed and ensures more rigid case 
standards for consistency.
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DSC-6000-31755 Users must have local administrator 
privileges to install the ServiceCenter 
client. If the client is installed in the 
default installation directory, C:\Program 
Files\Peregrine Systems\ServiceCenter 
Client\, the administrator must perform 
additional steps to enable write 
permissions to the ServiceCenter Client 
directory for the User group.

The write permissions enable users from 
the Users group to log in to use the client. 
The workspace directory is then shared by 
all users. Administrators can alternatively 
modify the Start menu link to specify a 
new workspace directory with write 
permissions for each User's group login.

A new workspace directory is created for 
each user login using the data directory 
parameter in the target path for the Start 
menu. The workspace directory is then 
exclusive for each login and not shared 
among users.

For non-system administrators to start 
the ServiceCenter client, ensure that you 
install the client in a folder that everyone 
has permission to read, write, and 
execute. You can optionally enable users 
with permissions for the ServiceCenter 
Client directory. 

Use one of the following two options to 
enable a shortcut and make it visible to 
non-system administrators:

Option 1

Perform the following steps to set the 
workspace to a local directory:

1 Type set from the command line to 
display user profile information.

2 Click Start > Programs > 
ServiceCenter Client.

3 Right-click ServiceCenter Client > 
Properties.

4 Modify the target directory, as follows: 
C:\Program Files\Peregrine 
Systems\ServiceCenter 
Client\ServiceCenter.exe -data 
\"%USERPROFILE%\scworkspace\" 
-vmargs -Xmx128M 
The data %USERPROFILE%\scworkspace 
parameter in the above line creates the 
scworkspace directory that contains 
the .metadata files and folders for each 
login. The information is then stored in 
the following file: 
C:\Documents and Settings\ 
user_name\scworkspace\ 
.metadata

Option 2

Perform the following steps to create a 
distributable shortcut:

1 Setup a shortcut to C:\Program Files\ 
Peregrine Systems\ServiceCenter 
Client\ServiceCenter.exe2.

2 Specify the Start in directory as your 
user-specific work directory, such as 
%USERPROFILE%.
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DSC-6000-31758 Screen readers are inconsistent when 
reading field descriptions using the Web 
client in Accessible mode. For example, if 
you log in as an end user and the screen is 
automatically read, titles and field 
descriptions are read. However, if you 
manually tab through the screen, the titles 
and field descriptions are not read but are 
instead passed over by the screen reader. 
The titles and field descriptions not read 
are generally those that do not have an 
input text field or link associated with 
them, although that is not always the case. 
For example, if you log in as 
BOB.HELPDESK and navigate to 
Maintenance > Contacts, the Form 
Options description and the Corp 
Struct/Div title are not read when tabbing 
through the screen. Instead, the Corp 
Struct/Div title has a text field and fill 
form associated with it.

Note:  This also occurs when logged in as 
an administrative user.

None.

DSC-6000-31759 To function properly, forms must have 
the focus correctly set to enable keyboard 
shortcut methods, such as using the Enter 
key on a search screen.

Use the mouse to click anywhere in a form 
to ensure the focus is properly set on the 
selected screen.
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DSC-6000-31760 When the Certification Authority (CA) 
certificate is not in the packaged client 
directories, you must install the 
repackaged client, as well as the certificate, 
in the same absolute path every time.

For example, when using the Client 
Packaging Utility to create a default login 
for a repackaged client, the default 
connection can be configured to use a 
Secure Socket Layer (SSL) connection. 
This connection requires a valid CA 
certificates file. The defined path to the 
CA Certificates file is based on the home 
directory of the client that is being 
modified by the Client Packaging Utility. 
If the repackaged client MSI is then 
installed in a directory that is different 
from the original home directory, the 
default connection will display the 
following error message after attempting 
to connect to the server:
"Error Connecting to server, server not up 
or wrong connection parameters: 
https://localhost:12670 "Cause: 
javax.xml.soap.SOAPException: Message 
send failed   
sun.security.validator.ValidatorException: 
No trusted certificate found

You can correctly enable Secure Sockets 
Layer (SSL) encryption with the Client 
Packaging Utility using one of the 
following methods:

1 When you define a default connection 
configured to use SSL encryption, 
install the repackaged MSI client in the 
same installation directory where you 
installed the original client. 
– OR –

2 If the repackaged client is installed in a 
different directory than the original 
home directory, which is the default 
connection, edit it by selecting the 
Advanced Connection option and then 
defining the correct path to the valid 
CA certificate file.
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DSC-6000-31762 Both the Web client and the Windows 
client contain a new date object to display 
dates. The new date object includes a 
built-in calendar widget. This widget 
replaces the previous calendar pop-up 
generated with earlier versions of 
ServiceCenter when using the Fill 
functionality in a date field. The date 
calendar pop-up does not display because 
the Data Type attribute is not passed to 
the date and time fields. If the data type 
for an object is shown as a date, the 
ServiceCenter 6 client dynamically selects 
and uses the new date object to display the 
calendar widget.

On clients earlier than version 6, the date 
displays using the object specified for the 
field in Forms Designer. This dynamic 
substitution is now used for the Web 
client.

In some instances, such as the first time a 
form is displayed during a client session, 
the Web client may not contain the data 
type information needed for the field. In 
that case, the Web client displays the 
specified Forms Designer object and, 
upon refresh, the client uses the new date 
object for all further displays of the date 
and time fields.

To ensure that the date field displays 
correctly on the Web client with the new 
date object and the accompanying 
calendar widget, you must convert old 
objects for date and time fields to the new 
date object using the ServiceCenter 6 
Forms Designer.

Note:  This is particularly important for 
Fill or ComFill objects.

31763 The Forms Designer is considerably 
different than previous versions. Once 
you make changes to a form using the 
version 6 Forms Designer, you cannot 
make changes to that form with a 
previous version of Forms Designer.

Once you begin modifying forms with a 
version 6 Windows client, do not use an 
older version of the client to modify 
forms. Ensure that users on clients earlier 
than version 6 also use the earlier version 
of Forms Designer.

31765 The Advanced Debugger may not 
correctly interpret Rapid Application 
Development (RAD) expressions.

Use the RAD Debugger instead of the 
Advanced Debugger if you have problems 
achieving your expected interpretation 
results.

31766 On the Web client, you cannot use the 
pull-down menu to print.

Use the Print icon in the Display area to 
print from the Web client. The pull-down 
menu can only be used for server-side 
printing.
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DSC-6000-31767 Print output contains overlaps for records 
in notebooks with tables. Printing 
overlaps in notebooks are automatically 
corrected with tables that are extended to 
view all table contents. For tables that 
display side-by-side or tables with 
adjacent elements, the overlaps continue 
to appear.

None. For more information, see the 
Forms Designer Best Practices Guide for a 
solution to this and other issues related to 
Forms design.

DSC-6000-31771 When running a 5.0.x or earlier version of 
the WebSphere Application server using 
the 1.3.x version of the Java Developers 
Toolkit (JDK), charts do not display in the 
browser for users running on UNIX 
without the DISPLAY environment 
variable set and without X windows 
running. Instead, an error is written to the 
log stating that it cannot connect to :0.0 
when trying to initialize the font for the 
chart.

This occurs because the WebSphere 
Application Server versions 5.0.x and 
earlier use version 1.3.1 JDK.

Set the DISPLAY environment variable 
for the process running the application 
server to an X server that the application 
server has access to. The information is 
then used to retrieve font and geometry 
details for chart creation.

DSC-6000-31774 The Export to Excel option does not 
correctly process Unicode (UTF-8) data. 
Correct UTF-8 data is sent but becomes 
garbled during the DDE transport. Export 
of Latin-1 or Japanese data correctly 
exports to Excel but there is no generic 
support for the DDE-based export of all 
supported UTF-8 languages.

You cannot use the Export to Excel 
feature with UTF-8 support if you use 
multiple languages other than Latin-1 and 
Japanese. You must instead use the Export 
to Text File feature. You can then convert 
the exported text to Excel.

DSC-6000-31777 When adding a field to an existing key in 
the System Navigator, the red star that 
typically displays to alert users that there 
are changes to be saved does not appear.

Save the new field in the Database 
Definition node by right-clicking on the 
node and then click Save.
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DSC-6000-31778 When using the Web client in accessible 
mode, it is difficult to comprehend forms 
that contain both read-only and non 
read-only elements. As a result, the 
read-only Form elements in the Web 
client are generated as inputs, even when 
they are read-only. This is the only 
available method that correctly associates 
labels with the actual input in order to 
benefit the client in accessible mode.

To ensure accessibility, all read-only form 
elements must be inputs. ServiceCenter 
was intentionally designed this way with 
some read-only fields that are not input 
fields due to the risks associated with this 
problem and to ensure that users with 
accessibility needs are not impacted.

DSC-6000-31780 The Extensible Stylesheet Language 
Transformations (XSLT) compiler does 
not function properly when using the 
WebSphere Application Server, Version 
5.1.x. The Web application immediately 
redirects to the farewell form 
\"goodbye.do ?\" and only briefly passes 
by the login form.

Use one of the following methods to 
correctly enable the XSLT compiler for a 
version 5.1.x WebSphere Application 
Server:

1 Download Xalan from the Apache Web 
site at http://xml.apache.org

2 Create a directory named endorsed 
under the following directory: 
.../$WAS_HOME/java/jre/lib

3 Copy the xalan.jar file you downloaded 
from the Apache site in the new 
directory.

If applications are dependent on the 
behavior of the IBM XSLT4J 2.5.4 version 
of Xalan, it will now be overridden by the 
Apache Xalan and may result in 
additional issues. 
– OR – 

1 Add a new setting in the local.xml file 
sc.war deploy directory, located at 
.../WEB-INF/local.xml.

2 Add the following setting: 
<transformerFactory>org.apache.xalan.
transformer.TransformerImpl</transfor
merFactory>

If you use the second option, the Web 
application now has instructions to use 
the Xalan-interpreted mode instead of the 
compiled mode and the Web client will 
run slower. Although slower, this option 
does not have the potential tjat the first 
option has to affect other applications.
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DSC-6000-31781 You can sometimes receive System Out of 
Handles errors with excessive or extended 
use of the System Navigator. This rarely 
occurs and only occurs on the Windows 
client.

None. Restart the client.

DSC-6000-31783 When you create a private Favorite in 
Favorites and Dashboards, a query is 
saved to a file. When you later open the 
Favorite, the client sends the query to the 
server. There is no screen specification for 
Rapid Application Development (RAD) 
context; therefore, the server attempts to 
open the default screen for the file to 
display the record set.

End users with restricted access may not 
be able to use the default screens and may 
only be allowed to view simplified screens 
using RAD applications. They can create 
favorites in Favorites and Dashboards, 
but may not be able to reopen and use 
them later.

If an end user with restricted access needs 
to create a Favorite in Favorites and 
Dashboards to use again later, give that 
user additional access to the default 
screens.

DSC-6000-31787 The label for an attribute is now added to 
labels for Array tables in order to establish 
the association between an array element 
and the corresponding label. Jaws 
Technology (JAWS) does not associate 
the Fills or the Combos in the table with 
the corresponding label.

None.

DSC-6000-31788 Displayed buttons sometimes overlap. 
For example, a button and a frame may be 
designed with identical positions and sizes 
and they may both contain DVD 
conditions that specify that they will be 
visible at a given time. Since the frame is a 
container, it may incorrectly determine 
that the button should be contained 
within the frame. Other components 
intended to be contained in the frame 
may be overlaid by, or contained within, 
the button.

If you need to create an available button 
with DVD conditions, the visibility for the 
button should be based on the condition 
rather than hiding it under another 
component.

You can optionally enable or disable 
buttons programmatically.
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DSC-6000-31794 When a user attempts to sort a list on a 
column mapped to a Binary Large Object 
(BLOB) or image, the list disappears. 
When this occurs, ServiceCenter displays 
a message similar to the following Oracle 
message: "sqlExec error: sqlcode=932 
errortext=ORA-00932: inconsistent 
datatypes: expected - got BLOB 
(display,fdisp.1)
This behavior occurs because the field you 
are attempting to sort is of the data type 
BLOB and some relational database 
systems, such as Oracle, do not support 
the sorting of BLOBs. If you receive an 
error message that is similar to the one 
above, the problem is likely due to 
mapping a type of field that is not 
sortable.

Remap the field to a varchar type field 
using the sqldbinfo file.

For additional information and 
procedures, see the Database Conversion 
and RDBMS Support Guide.

DSC-6000-31797 If the visibility of a control is set to FALSE 
in Forms Designer, the DVD condition is 
ignored.

To correct this issue, set the Visibility to 
TRUE in FormDesigner.

DSC-6000-31798 Formats with Combo boxes that contain 
large record sets display slowly on 
Microsoft Internet Explorer (IE).

Designing these forms with Fill boxes 
instead of Combo boxes will increase the 
display speed using Microsoft Internet 
Explorer (IE).

You can optionally view the form as-is 
using Mozilla.
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DSC-6000-31800 The following display irregularities can 
occur when using the Web client:

For notebooks and tables, you cannot 
position a notebook object next to 
another large form object, such as a 
table. In the Web client, the result 
appears as a form that is always greater 
than 100% in width.
The Web client does not display colored 
text. Text effects that rely on color to 
render, such as drop shadows, do not 
display in the Web client.
For virtual joins and multiple records, 
when using a virtual join to display 
multiple records on a form, you must 
use the table object to ensure that the 
records display correctly. 

For Notebooks and tables, form objects to 
the right of the notebook scroll from the 
browser page.

There is no workaround for colored text 
or text effects that rely on color to 
correctly display the effect.

For virtual joins used to display multiple 
records on a form, use the table object to 
ensure that the records display correctly.

DSC-6000-31801 The Windows service associated with the 
Help server is not removed during the 
uninstall process for the Help server.

Before uninstalling the Help server, you 
must manually remove the Windows 
service associated with the Help server.

Click Start > ServiceCenter Help Server > 
Remove Help Server Service to manually 
remove the Windows service associated 
with the Help server.

DSC-6000-31802 The Web client does not support the 
design mode for Administrators using the 
Forms Designer utility. When using the 
Web client, the design button displays but 
does not function.

Perform the following steps to use the 
Forms Designer utility on a Web client:

1 From Database Manager, select 
displayoptions.

2 Type design in the Action field.
3 Edit the condition so to reads as 

follows: 
gui() and $L.editable and 
sysinfo.get(\"Environment\")~#\"scguiw
web\"

DSC-6000-31153 At the time of this release, AIX 5.1 is not a 
supported platform for ServiceCenter 6.

Contact customer support for an updated 
build that includes support for AIX 5.1.
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Documentation

ServiceCenter documentation is primarily available as field help and online 
help within the application. With ServiceCenter 6, administrators can now 
customize both the field help and the online help.

For reference information and information about concepts and procedures, 
you can access and navigate the online help. The online help can be stored 
locally with each Windows client or served from a Help server.

Accessing field level help

1 Place your cursor in the text box for a specific field.

2 Click Help > Help on Field or use the CTRL + H keystroke combination.

Accessing online help from a Windows client

1 From the Windows Start menu, click Start > Programs > ServiceCenter 
Client.

2 Click Help > Contents.

Note: It is not required to connect to a server to view the online help.

Accessing online help from a Help server

1 Install a Help server using the instructions provided in the ServiceCenter 
Installation Guide.

2 You can then access the online help from within the Windows client or from 
any supported Web browser.

If you have large groups or teams that need to learn about ServiceCenter 6, 
you can install the Help server on a machine that can be accessed by each 
team member’s browser. 

Upgrades

If you are planning to upgrade your ServiceCenter applications, you must use 
the Application Upgrade Utility. Peregrine has many resources to ensure 
your upgrade success. You can visit the Upgrade Center on the Customer 
Support Web site or contact Peregrine Customer Support to learn more 
about these options.
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Language enablement and Unicode (UTF-8) support

ServiceCenter 6 supports language enablement and Unicode (UTF-8) 
encoding with translated formats, messages, and online help.

UTF-8 is part of the Unicode standard that allows you to store characters 
from any supported language. ServiceCenter 6 supports UTF-8 as an 
encoding method for new or existing data and can support multiple 
languages on a single server while adhering to the Unicode standard.

After ServiceCenter 6 is enabled for a language, users can enter and retrieve 
data and create forms and messages in that language.

Using multiple versions of the client with ServiceCenter 6
Consider the following when deciding whether or not to deploy 
ServiceCenter 6 with both old and new clients:

Although the ServiceCenter 6 server can now store and serve data in any 
language, this feature cannot be fully exploited if you choose to use 
previous versions of ServiceCenter clients. On previous versions of the 
client, you can only enter or display characters from a single family of 
languages, such as Latin-1 or Cyrillic. When installing the new client, 
UTF-8 encoding is not an optional, it is part of the required installation. 
You cannot run ServiceCenter 6 until the installation process is successful 
in converting all P4 files to UTF-8.

If you choose to deploy a ServiceCenter 6 server with both old and new 
clients, users of the new clients are UTF-8 capable. They can easily create 
or update records containing characters that cannot be viewed or updated 
by users operating with an older version of the client.

Once users of the new client introduce UTF-8 characters into a record, the 
record is no longer available for updates using any previous version of the 
client. If you review this section and still choose to deploy both old and 
new versions of the client with a ServiceCenter 6 server, ensure that users 
with older versions of the client are aware that they cannot update any 
records after they are modified using the new client.

Even when all users are in the same country and using the same language 
settings, UTF-8 multibyte characters can easily be introduced into your 
ServiceCenter 6 database. For example, a user might paste the text from an 
email into an incident description and that text may contain UTF-8 
characters.
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If you have a business need that requires temporary deployment of both 
old and new versions of the client, use the following guidelines:

Maintain your existing sc.ini language setting. Do not change the setting 
to UTF-8. Changing the setting can cause problems because the setting 
declares that all clients, regardless of version, use UTF-8. The older 
clients do not use or support UTF-8 encoding.

Do not attempt to consolidate multiple servers that previously ran with 
different language parameters until all old clients are successfully 
removed from your working environment.

You must decide within your organization whether or not to convert 
your RDBMS to UTF-8. You can convert your database to UTF-8 
regardless of the client you select. The database is controlled by the new 
dblanguage parameter and all data is internally manipulated in UTF-8 
using this parameter. For information about your converting your 
database to UTF-8, consult your local Database Administrator and the 
documentation provided by your RDBMS vendor.

Consider the following before deploying your ServiceCenter 6 server, 
which will automatically enable UTF-8 encoding. Do this only if you are 
planning a first-time installation or if your ServiceCenter 6 server is 
already deployed without older versions of the client.

Ensure you have no earlier versions of the ServiceCenter client and are 
running only ServiceCenter 6 clients. UTF-8 support is not supported 
on clients earlier than version 6.

Specify the language:utf8 parameter in the sc.ini file or from the 
command line. This instructs the server to move data in the UTF-8 
format to external sources. This includes all clients, exporting data to a 
text file, and initiating server-side printing. The conversion of the 
existing data is transparent and is only performed on an as-needed 
basis.

Ensure that any mapped Relational Database Management System 
(RDBMS) is correctly configured for UTF-8 support. For information 
about your current configuration, consult your local Database 
Administrator and the documentation provided by your RDBMS 
vendor.

When entering and retrieving data in another language, you must use 
the appropriate keyboard for the selected language, a keyboard input 
method editor (IME), or other proven means of keyed entry.
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For additional information about UTF-8 support and data conversion, see 
UTF-8 (Unicode) Support section of the online help, the Upgrade Utility 
Guide, and the Database Conversion and RDBMS Support Guide.

Third-party product support

Peregrine products often integrate with third-party products using open 
source standards. The Peregrine Customer Support Web site contains 
specific statements about the support of third-party products and open 
source standards. To read more about these statements, perform the 
following steps:

Accessing third-party product support information

1 Open a browser and navigate to the Peregrine Customer Support Web site at:

http://support.peregrine.com

2 Log in with your Customer login ID and password.

3 Click General Information in the left frame.

4 Click Third-party product support in the right frame to display a list of 
third-party products and the corresponding support statements for each.

Need further assistance?

For further information and assistance with this release or ServiceCenter 
general, contact Peregrine Customer Support.

Peregrine Customer Support Web site
Current details for local support offices is available through the main 
contacts shown below or on the Peregrine Customer Support Web site.

Accessing the Peregrine Customer Support Web site

1 Open a browser and navigate to the Peregrine Customer Support Web site at:

http://support.peregrine.com
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2 Log in to the Customer Support Web site using your Customer login ID and 
password.

3 From the Support home page, click Phone Support in the left frame to 
display the Peregrine Worldwide Contact information.

Education services
Peregrine Systems offers classroom training anywhere in the world, as well as 
“at your desk” training via the Internet. For a complete listing of Peregrine 
training courses, see the Peregrine Education Service Web site at:

http://support.peregrine.com/education

You can also call Peregrine Education Services at +1 858.794.5009.

Corporate headquarters

You can access a list of worldwide contact numbers by logging on to the 
Customer Support Web site and then clicking Phone Support.

You can access the Customer Support Web site at:

http://support.peregrine.com

Contact Customer Support at Peregrine headquarters at:

Address: Peregrine Systems, Inc. 
Attn: Customer Support 
3611 Valley Centre Drive 
San Diego, CA 92130 USA

Telephone + (1) (858) 794-7428

Fax: + (1) (858) 480-3928

Email: support@peregrine.com
38  ServiceCenter 6 Release Notes 

http://support.peregrine.com
http://support.peregrine.com




June 29, 2004


	Contents
	Getting started
	Comparing clients
	New features
	What’s new for application developers?
	What’s new for administrators?
	What’s new for end users?

	Compatibility matrix
	Software Change Requests (SCRs)
	Known issues
	Documentation
	Upgrades
	Language enablement and Unicode (UTF-8) support
	Using multiple versions of the client with ServiceCenter 6

	Third-party product support
	Need further assistance?
	Peregrine Customer Support Web site
	Education services

	Corporate headquarters

